PaleoTax/Measure
Program Release 1.3 (1 November 2013)

Introduction
What is PaleoTax/Measure?
PaleoTax/Measure (PM) is a tool to measure two dimensional objects with a size of up to one metre.
The resolution of PM is 0.001 mm (1 µm). It is possible to measure distances and areas, and to count
objects. The program is a clone of PaleoTax/Map, but here the total map size is not at global scale, but
is an area of 1m2. It is (currently) totally independent of PaleoTax. A future version may be made
available as a Plug-in for PaleoTax in order to ease the measuring of images administrated by PaleoTax.
Why PaleoTax/Measure?
PaleoTax/Measure allows, in a very short time span, the recording of a high number of distances and
areas of various types (which the user can define), or counting of objects.
Values obtained through PM are much more accurate than those taken manually with a ruler.
The program automatically calculates arithmetic mean, standard deviation, coefficient of variance and
the first interval from the obtained values (distances, areas, counts).
The program allows to export the measured data as a plain text file, which makes it easy to import it
into any spreadsheet program.
Values can be classified and the results can be used in distribution analysis.
Data can be stored (in ASCII files) and reloadedp, modified and completed. Values can be deleted
from a table or directly in the image.
What to measure?
PaleoTax/Measure helps to measure any plane object such as photographed leaves, any sectioned or
thin-sectioned object, biological preparations, etc. The smallest distance which can be measured is
0.001mm (1µm). The maximum working area is 1m2. The object to be measured must be available as
JPG or BMP file. The resolution (scale) depends on the size of the object and the expected exactness. If
the scale is too large, the work goes slightly slower, because of the size of the image file; if the scale is
too small, the object appears blurred and makes exact measurement difficult. Some experience can help
to clarify which is the best resolution. To gain a first experience, divide the size of the area in µm
(1000000) by the smallest value to be measured (in µm). For the smallest distance of 100µm, the
resolution should be about 10000dpi (1000000/100). If the smallest value is 2mm (1000000/2000), the
recommended resolution is 500dpi. A slightly higher resolution gives more exact results. Objects to be
measured must be available as files. JPG gives smaller files, but it is slower; BMP gives larger files, but it
is faster. The maximum size of an image which can be processed depends on the main memory of your
computer; if the image is too large, it will simply not be displayed. If it is not possible to quantify that;
count 20MB JPG file size for each free 500MB of main memory in your computer, as a maximum.
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What is new in this version?
Compared to version 1.0 the following important changes were made:
Display speed is much higher.
Segments can be deleted from the table or in the image.
More statistical values are calculated.
Results are displayed in a table.
More output formats.
Compared to version 1.1, the following changes were made:
The program works generally better under Windows Vista and higher versions.
It can be selected which values are given in the Screen output format. The output text can
automatically be transferred into the Windows clipboard.
It has become easier to append new data types.
Compared to version 1.1.1, the following changes were made:
The areas of polygons are now calculated and included in statistics.
Points of polygons can be modified and deleted.
Statistical values for text labels are calculated when the text represents numbers.
A new data type, ‘Count’ is introduced.
A summary of the measured values can be displayed.
Adaptation to virtual installations of Windows (‘graph file read error’ can be bypassed, see below
Problems and limitations), and to Windows 7/8.
Compared to version 1.2, the following changes were made:
It is possible to modify the size of the dot when measuring or modifying data (Options/Display/Point
size).
The length of TP Lines can be displayed (Options/Display/Show values of TP Lines).
Maximum font size for the window of all statistical values can be defined (Options/Display/Max font
size statistic).
Values can be output to be able to be imported by the statistical program package R.
Editing values of the count object (remove, add) is possible now. Set the Edit mode, press ALT and
click at one point. This point will be duplicated and integrated in the current group. Take care not to
use the first and not the last point in the group.
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Coefficient of variation according to K. Pearson
*100/µ
First interval
µ±
Range – percentage of the values which falls into the first interval.

How to use the program
Install and Uninstall
PaleoTax/Measure no longer forms a part of the Hdb2Win/PaleoTax database package; it comes in a
separate package. The separate version is more frequently updated, whereas the package version is only
updated when the whole package makes a step to a new version. Download the installation file from
http://www.paleotax.de/measure and run the installation program (pm130xx.exe). You probably should
have administrator rights to do so. To remove the program from your PC use the functionality of the
operating system (Start / Control / Programs) uninstalling “PMeasure 1.3 (only uninstall)”. The uninstallation program is also installed in the program folder; you may find it in Start / All programs /
PMeasure13. You may keep older versions; you do not need to remove them before installation of
version 1.3. Your data and settings will not be affected by removing any older version of the program
from the computer.
Get started
In starting PM, you will see a menu, a tool bar, the working area, a bottom status bar and - on the right
hand side - two tables (the upper for the values, the lower for the results). The language is, by default,
set to English and if it is for any reason (perhaps, because of an older installation) in German and you
want to change it, choose “Optionen”, and select the English language under “Sprache”. You do not
need to restart PaleoTax/Measure. Configuration files are kept in c:\Users\<username>\AppData\
Roaming\Hdb2Win\(Windows 7/8) or C:\Documents and settings\<username>\AppData\Hdb2Win\
(Windows XP).
To start to measure, open the file menu, choose “New” (or press Ctrl-N, or click on the symbol in the
tool bar) and select a bitmap file (JPG or BMP). You will be asked to enter the resolution of the image.
The resolution is the value you choose in your scanner when scanning the object/thin section/peel, etc. If
you have not scanned the object yourself, it should have at least a scale bar. Open a program to handle
bitmap files and measure the size of this scale bar in pixel. Let us assume that the scale bar represents
five millimetres and you measured a length of 420 pixel; you should enter the value as “420/5”. See the
examples below.
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The program will recognise that you have not entered a resolution and will calculate the correct
resolution, automatically. After having chosen a graph file and entering the resolution, the image is
displayed in the working area with the correct resolution given in the status bar.

Now you can enlarge or reduce the size of the image, see parts (hold the left mouse button down and
draw a rectangle to the lower right) or return to the original size by clicking on the world symbol. With
the magnification tool you can reduce (+) or enlarge the size of area, stepwise (-).
To measure values, click on the pin tool. Then click at the first point of the line to be drawn (measure).
If you have not chosen before a distance type from the top selection box, just on the right hand side of
the tool bar, a menu will open to offer you the standard tools.

By default, there are six different objects types: points (optional with a label), lines with various points,
polygons, texts, two point lines and counts. You may use all, but only two point lines (TPLs) and
polygons will allow you to measure and calculate values. Texts will be calculated when they represent
numerical values. Counts represent a group of points (like a polygon); the amount of points of various
group are statistically classified. You can select the available TPL data type 155 or polygon type 153 or
count type 156, but it is a better idea to create your own data types. To do so, click on “New”.
But, before starting, some considerations are recommended. A plane object allows to measure – depending on its shape and characteristics – various types of values. If you have a leaf, you can measure the
height and width and some subsequent values, depending on the type of leaf. If you measure a more
complicated object like a foraminifer or a coral, much more values can be obtained (see the example on
the next page). It is useful to address each data type with a different (TPL, polygon, count) type (that
you may create by clicking on “New”). It is a good idea to first make a list and put the most used data
types at the top of the list and to create them first. It easy to create them through the menu item Edit /
New data type.
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If you create a new data type, the (default) properties of the last used data type are copied into this data
type. If there is no formerly created data type, the standard values of the TPLine / polygon are applied
(see the figure on the next page, top). Enter a name in the field, preferably in the form “abbreviation
(explanation)” and adapt line colour and thickness to your needs. Only if you append a new data type,
may you select the object type (line, point, etc.). If you already have a list of data types and you want to
edit them, choose the item “Object characteristics” in the Edit menu.
How to measure
Measuring starts by clicking on the pin symbol. It ends by clicking on the pin symbol, choosing the edit
symbol, or changing the current data type. If a data type is selected on the top of the table on the right
hand side, the pin symbol turns green and you may start. If no data type is selected, a window pops up
and forces you to select the data type you want to measure.
Two point line. – Two points always define a two point line. You may continuously measure.
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Polygon. – Polygons consist of a group of points that limit an area. Click on the pin tool to start. Mark
your polygon by clicking on the limits. Click again on the pin tool to close the polygon. Start with a new
polygon or click again on the pin tool to stop measuring this data type.
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Count. – Count consists of polygons of a group of points without showing the area they delimit. Click
on the pin tool to start and click again on the pin tool to finish with this group. Start with a new group
or click again on the pin tool to stop measuring this data type. The result of counting one group is
shown in the centre of the group of points.

Text. - If counting by clicking is not fast enough, you may just count, select the text type, click
somewhere in your image and enter the numerical value in the text field. The program recognises the
numerical value and processes the data.

How to edit data
Single values can be easily deleted by double clicking in the table of the values. When clicking on the
Modify tool (tool bar, most right tool), the following modifications are possible. Clicking left on a point,
holding and moving the mouse will move the point.
Right click on a point,
TP Line – The TP line will be completely removed.
Point – The point will be removed.
Polygon – Only one point of the polygon will be removed.
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Text – A right-click in the upper left corner of the label deletes the text.
Count – Only one point of the count object will be removed.
Holding ALT and clicking left on a point duplicates the point. This works only for Count objects. After
duplicating a point it mkes sense to move the newly created point. To doing so with the first or last
point of a group will display an error code (1 or 2). Error code 3 will reported when the datatable is full
or the selected point cannot be assigned to any existing group.

Systematic description
Menus
File menu
New (^N) – New project. Selection of an image file (JPG, BMP) and entering a resolution.
Open (^O) – Opens an existing (PMP, PaleoTax Measure Project) file. This file contains (in the ASCII
format) the path and name of the image, its resolution, and already recorded data. If the image file
is not found, you may select it manually.
Save (^S) – Saves the current project. If no name has been so far assigned to the project, you have to
choose the path and to enter the file name. Please note, that the image is not saved in the project
file, just its position on your hard disk is saved. So do not remove the image file.
Save as – Saves the current project under a different or new name.
Export – Offers various options.
WMF
Windows MetaFile.
BMP
Bitmap.
Text
Exports the values as an ANSI file, which can be imported into any spreadsheet
application. It classifies values according the value Options / Display / Class Size.
The unit of the class size is always µm.
Screen
Summarises the calculated values for all measured types in the form of a short
report without giving the detailed data. You may choose the values you need in
Options / Export / Output “Screen”.
PaleoGraph Writes a PGR file of the first three values which can be displayed in
PaleoTax/Graph. Class size as above.
R
Exports the values as an ANSI file, which can be imported into the statistic
programm R.
Properties – Gives information about the current project.
Reset (^R) – Closes the current project. You are asked if you want to save the current project.
Exit (ALT+X) – Leaves the program.
Edit menu
Refresh – Refreshes the display. Space key makes the same.
Object characteristics – Offers the possibility to modify colour, line length etc. of the various data types.
New data type – Appends a new data type.
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View menu
All – Shows the whole image.
Reduce – Reduces the size of the image. The percentage value can be modified in the options.
Enlarge – Enlarges the size of the image. The percentage value can be modified in the options.
Options menu
Data/System
Data path – Path for the PaleoTax Measure Project files.
Object file – Name of the file which contains the description of objects.
Bitmap folder – Name of the current image folder.
Pool folder (Images) – This is a folder name where the program may search for images if they are not
found in the original folder.
Image drive – Pool drive where the program may search for images if they are not found in the original
drive.
Language – Language of menus, etc.
User data – Amount of records which can be recorded by the user at the same time.
Display warning errors – If marked, also warning errors are shown (generally, just for testing the
software).
Registered for – Registration is, currently, not necessary.
Display
Enlarge (+) by – Percentage of enlargement when the + key is pressed, the Enlarge command used from
the View Menu or clicked in the + tool.
Reduce (-) by – Percentage of reduction when the - key is pressed, the Reduction command used from
the View Menu or clicked in the - tool. Enlarge and reduce should be proportional values. This
does not mean that they are identical (because, they are percentages). Valid pairs are 80–125 (with
a very low rate of enlargement and reduction), 40–250, 20–500 and 10–1000 (with a very high
rate of enlargement and reduction).
Fine scaling – Percentage of enlargement or reduction when the up or down arrow is clicked in the
magnification tool in the toolbar.
Partition raster – Number of horizontal and vertical grid lines on the working area.
Distance grid labels – Distance of grid labels from the grid lines.
Minimum zoom size – The smallest size (in pixel) when a new frame is selected by pressing and holding
the left mouse button and drawing the window.
Width of measure area – To obtain a correct scale bar, you should measure the width of the image area
(in mm) displayed on your screen and enter here.
Unit of the table of values – Select the unit which should be used in the table and export.
Ask for names when recording data manually (points, vectors, polygons) – Asks for names for any
point, or point of a line or polygon.
Snap to grid – If marked, the selection of a smaller working area orientates on the grid.
Hide unselected values – During data recording all data which do not belong to the currently recorded
type are shown as black thin lines.
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XP Mode “Adjust for best performance” (it is better to restart after modification) – If working with the
operating system Windows XP and having set the performance to “Adjust for best performance”
this option should be switched on, because it makes a more optimal use of the screen. It is better
to restart the program after switching on or off this option.
Show values of TP Lines – Displays the numerical value of TP lines. Only values of the selected data
type are shown.
Class size – Size of the class when exporting data as text files and showing as diagram in the display.
The unit is always µm. Class size should be ca. 3% of the average of the measured values. If, for
instance, the average of your values is 2 mm, the approximate class size should be 60 µm. It is
possible to calculate the class size always on the base of a given percentage of the average (see
below). - Switch the layer (9) on to see how values are distributed.
Adapt class size – If switched on, the class size will be calculate as a percentage of the average.
Calculation will be made after any change of values.
% of the average – Enter here the percentage of the average for calculation the class size. Value must be
between 1 and 99.
Point size (record) – Size of the point in pixel when data are recorded.
Point size (edit) – Size of the point in pixel when data are edited.
Background colour – Background colour of the working area.
Transparent colour – Colour in images to be transparent, say, any pixel with this colour in the imported
image will show the background colour.
Change layer order – Modifies the order of the different layers in the working area. You do not need to
change that, but if you like, you may switch off the boxes at the bottom of the working area (“(9)
Histogram” and “(10) Statistics”). If both are switched on, layer 10 should be the last item in the
list.
Export
Adapt export to CDR – Only valid for the export to the WMF format to avoid problems when importing
the WMF file into CorelDraw (can be also the case for other vector oriented drawing programs).
Output “Screen” – List of values which are shown in the Screen output mode.
Decimal places of accuracy – Number of decimals that will be shows in the screen output.
Working area
The working area is always quadratic, e.g. height and width have the same size (this makes calculation
much easier). There is a grid in which density of the grid lines can be controlled by the user. In the left
lower corner is a small scale which only works if you enter the size of the working area in mm on your
screen. To do so, you should start the program, adapt its size to your needs or the screen size, take a
ruler and measure the value of the area. The value (mm) you enter in the options (Width of measure
area). If the value is 0 (by default), no scale will be displayed. If layer (9) is switched on, in the lower
right corner a diagram is displayed which shows the distribution of the measured values. Class size
according to the value defined in the options. If layer (10) is switched on, in the lower middle area a
overview for all recorded data is shown. Shown values according to Options / Export / Output Screen.
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Layers (9) and (10) are, by default, not active. They can be activated in Options / Display / Change
Layer Order. Layer (9) should be always displayed before layer (10), because otherwise the latter layer
is shown incompletely.
Toolbar
New, Open and Save – Self explaining.
Plus tool – Enlarges the size of the image. The percentage value can be modified in the options.
Minus tool – Reduces the size of the image. The percentage value can be modified in the options.
World tool – Shows the whole image.
Magnification tool – Enlarges or reduce the size of the image in small steps. The percentage value can
be modified in the options.
Grid tool – Increments or decrements the number of grid lines.
Pin tool – Activate to record data. Close a polygon or a group of points. Deactivate data recording.
Move tool – Activate to modify the position of points. When activated, points can be moved, or (rightclick) deleted.
Status bar
Field 1 – Name of the project (or image) and its resolution.
Field 2 – Factor of magnification (do not forget to enter the screen size in the options!).
Field 3 – Width of the image area in mm.
Field 4 – Size of the image in pixels (size in KB/MB).
Field 5 – Amount of recorded data, percentage of used space and status of being saved or not.
Tables
Top selection box
Here you can select the type of values you will take before selecting the pin-tool. Values of this type will
be displayed in the tables.
Values (upper) table
The table lists the values of a selected measure type (and only for this type!). Double click in a cell to
remove values from the table. Be sure that you have chosen the correct cell. You have to click in the
field of the value, not in that of the current number. Smallest and highest values are marked.
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Results (lower) table
The following results are given:
n – Number of measured values.
min – Minimal value.
max – Maximal value.
Arithm.mean – Arithmetic mean ( ) on the recorded values.
Variance – Variance of the recorded values.
Stand.Desv. – Standard deviation ( ) of all the recorded values.
s*100/µ – Coefficient of variance according to K. PEARSON.
µ±s – The amount (in percent) of measurements which falls into the (first) interval
first idea about the distribution of data.
Range – Amount of measurements which fall into the interval
and
.
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Problems and limitations
(1)
When PM is running under a virtual environment (e.g. under a Windows installed as a guest system on a
Unix or Mac OS operation system as a host using a virtual machine) and tries to read a large image from
a shared folder of the host system, a timeout error may occur (“Cannot read file”). The easiest way to
bypass this error is to make a local copy of the image file. To force PM to do so, you need to edit the
file, Pmeasure.cfg, manually (for the location of the file, see above under Get started). Open the file with
a plain text editor (such as Notepad.exe) and search line 26:
; Data.CopyImage
26
0
Change the value from 0 to 10. This value gives the size of the image file in MB from which the file is
copied into the root directory of your (virtual) hard disk C:\. If there still occur errors, reduce the value
to 5. Zero indicates that the file is never copied to the local drive (default setting).
(2)
It is possible to capture any type of polygon, but keep in mind that the calculation of the polygon area is
based on Surveyor's Formula which allows only simple, e.g. non-self-intersecting polygons. A polygon
must have at least three points.
(3)
User reported that the image is often not correctly displayed under Windows 7/8. A possible solution is
to set the performance to “Adjust for best performance”.
(4)
Make proposals concerning what else would be interesting for you. Give equations; function(s) can
easily be incorporated. See the next page, a typical picture - here, the various diameters of corallites, the
distance of corallites and the number of septa in a fossil colonial coral.
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Copyright information
The right to use the program freely without paying any fee does not imply that the program is without
copyright. If you use the program in your research and you will mention its application in the method
section of your publication(s), please refer to it in the following way
“PaleoTax/Measure 1.3 (http://www.paleotax.de/measure, © Hannes Löser)”
The program has been developed within the framework of my duties as researcher and lecturer at the
Universidad Nacional Autónoma de México (UNAM) and my university has the right to ask for
references to products of its faculty members. I would be grateful for receiving PDF files of your
publications where PaleoTax/Measure is mentioned.
Hdb2Win / PaleoTax Measure © H. Löser 2008-2013
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